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Help by topic
Introduction <-- Read me first!
The Display
Graphing Equations
Using the Redraw Queue
Using a printer with Graphmatica
Using Command Line Arguments
Shareware Screen

Help by menu item
File Menu: file and printing operations
Edit Menu: exporting text and images
Redraw Menu: manipulating the redraw queue
View Menu: Changing the appearance of the screen
Labels Menu: Labelling the grid with text
Options menu: Viewing and setting special options



GRAPHING HELP TOPICS
Graphing Equations: Basic Knowledge
These help topics apply to all types of graphs.
Entering Equations
Operator Table
Specifying a domain for graphs
Drawing Graphs
Error Messages

Different Graphing Techniques
Each topic describes how to draw one type of graph. Overview provides a brief description of
each type with a link to the full topic.
Overview
Normal Cartesian coordinate graphing
Polar-coordinate Graphing
Parametric Graphing
Differential Equations



Using AutoRedraw and the Redraw Queue
The Redraw Queue
Using AutoRedraw
Deleting an Equation
Clearing the Whole Queue
Saving and Loading Equation Lists
Editing Equation Lists



File Menu
Load List Saving and Loading Equation Lists
Save " "
Save Setup Info Saving Setup Information
Print Printing Pictures of Your Graphs
Printer Setup " "
Exit Quit Graphmatica for Windows



Redraw Menu: Manipulating the Redraw Queue
Last Graph Redraws the equation at the head of the queue, typically the last one 

entered.
All Graphs Redraws all graphs in the queue that are not already on-screen.
Delete Equation See Deleting an Equation
Clear All See Clearing the Whole Queue



View menu: Changing the appearance of the screen
Clear Screen Clearing the Screen
Scale Changing the scale
Range Adjusting the Range
Theta Range Changing the Range of Theta
Fineness Adjusting the Fineness



Labels Menu: Labelling the grid with text
Legends Turning Axis Legends on/off
Title Adding a Title to the Graph
Always On Labels Always On Option



Options menu: Viewing and setting special options
Settings Settings Dialog Box
AutoRedraw Using AutoRedraw
Warnings Turning Warning Messages on/off
Print Tables Printing Point Tables
Hog CPU Hog CPU Option
Monochrome Monochrome Option
AutoSquare AutoSquare Feature

The default values of each option are listed in Default Settings of Options



INTRODUCTION to Graphmatica for Windows
Graphmatica is an interactive algebraic equation grapher that can be used as an aide to 
plotting mathematical curves. While it is designed to be extremely simple to use, its 
advanced features may not be readily apparent to the first-time user. Please take a moment 
to acquaint yourself with them:

1. The Redraw Queue. Graphmatica remembers the last 25 equations you typed in or loaded
from a file. You can save your work for use in a later session or with any text editor or 
Graphmatica 3.0 for DOS.

2. Automatic functions. Graphmatica will automatically 
+ determine the type of graph you are entering,
+ recognize an equation's domain if you include one,
+ alter the sampling rate dynamically while graphing to make sure steep graphs like 

"y=tan x" are tracked correctly, 
+ adjust the x/y ratio when you reset the range or change the size of the graph window 

so proper aspect ratio is maintained, 
+ redraw the most recently-entered equation(s) when you change the size or shape of 

the grid by any means, and 
+ restore the grid and special options settings when you load an equation list that has 

them. 
You don't have to do anything to use these functions, but the Options menu still gives you
complete control over them.

3. Advanced equation parser follows mathematical rules--not the computer's. You can 
use implied multiplication, a complete library of math functions (including trig), and even 
leave out those annoying parentheses in appropriate places. Forget about isolating 
variables before graphing! As long as there is only one instance of the dependent variable
in the equation, Graphmatica will isolate it for you, and even graph relations. You also get 
the power of 5 styles of graphing: regular Cartesian, polar, parametric, and slope-field and
initial-value approximations for first-order ODE's, detected automatically.

4. Easy to use controls, including the convenient Button Bar which provides one-click 
access to the most frequently-used commands, the status bar, which displays relevant 
information and help messages, and the Redraw Queue combobox, which lets you select 
any equation in memory to graph, delete, or edit to form a new equation.

5. Pause and Print tables options let you see the coordinates of points on your graphs... as 
they are drawn. Print tables shows values at whole-number intervals so you can practice 
sketching curves yourself.

6. Lots of output options. Graphmatica lets you copy equations, point tables, and graphs 
to the clipboard [See Edit Menu options for details], and you can choose from three levels 
of print quality for faster or better printouts when you print your graphs. [See Printing 
Pictures of your Graphs].

7. Every automatic option is also user-settable to give you absolute control over your 
graphs. The Options Settings dialog not only shows you the current settings, but also acts 
as a master control panel to let you change any customizable option from one dialog box. 
And the Save Setup Info command lets you save your preferences so they are 
automatically restored whenever you run Graphmatica. 

8. Instructive help topics explain the basics of each type of graph...and included demo 
files show you examples of each form of equation. See Demo Files for a list of these files.



DEMONSTRATION FILES
Graphmatica comes equipped with the following demonstration files to show you examples 
of each kind of graph it can draw. Each file contains a group of related equations, and each 
equation has a comment attached describing the curve it generates.

Try loading each file up (with the Load List command in the File menu), manipulating the 
view of the equations, redrawing, and modifying some equations. I suggest clearing the 
screen (if not the redraw queue as well) before loading a new file so the screen doesn't 
become too cluttered.

GRAPHMAT.GR draws Graphmatica's name, mainly to show off the power of parametric 
equations

XYDEMO.GR Cartesian-coordinate equations, quadratic equations, relations
TRIG.GR graphs of trigonometric functions
POLAR.GR graphs using polar coordinates
DIFEQ.GR 1 slope field and 1 Cauchy-Euler approximation of a first-order differential 

equation.



ELEMENTS OF THE DISPLAY
Besides the standard Windows display elements like menus, Graphmatica also includes 
controls that you might expect in a professional-quality application. The bottom of the main 
window holds the status bar, which displays help messages from the menus, the result of 
the latest action completed, the status of a selected equation, and during graphing, the 
equation being graphed, any warning error messages (if desired), and the pause message. 
So as not to obstruct the graphs, any message that does not require immediate attention or 
input will be posted in the status bar.

Next, the Button Bar at the top of the window contains controls that allow you to perform the
most common commands with one click of the mouse or two keystrokes (Alt+letter). In 
addition, the zoom buttons zoom in and out using the default scale factor (the last value 
entered in the Scale dialog) so you don't have to enter a new one, and the range button lets 
you select the new range with the mouse so you don't even have to type in the new 
coordinates.

The Redraw Queue combobox serves two functions: first to accept input of new equations 
(you can type in a new equation at any time as long as you aren't currently graphing one) 
and second to retrieve old equations from the queue. If you want to enter a new equation, 
just type it in and press enter or click Graph to graph it. If a previous equation is highlighted 
on the input line, just start typing to start from scratch or press a direction key to clear the 
selection and edit it. To retrieve an old equation, use the up and down arrow keys to scroll 
through the list one equation at a time or click on the icon to the right of the edit field to 
drop down the list box for mouse selection (if there are more equations in the queue than fit 
in the box, it will have a scrollbar so you can see them all).

Finally, the Printout window (toggled on or off by the Print Tables menu item) shows the 
coordinates of selected points from the last graph(s) done with the option on. You may scroll 
through this list at will. Select however much of the point list you like and then select Copy 
from the Edit menu to copy the text of the printout to the Clipboard, so you can insert it into 
a document, print it, etc.



THE BUTTON BAR
Along the top of the screen below the menu bar is the Button Bar. This not only gives you 
convenient ways to perform tasks that can be done using the menus, but also lets you do a 
few more things. Following is a list of the buttons and their functions:

Graph Draws an equation you typed in or redraws the currently selected equation. 
Equivalent to pressing Enter.

Pause Activated only when you are graphing. Clicking this button (or pressing enter or 
escape) pauses the current graph. When you are pausing, the Graph button 
becomes ABORT. Click it to quit graphing or Pause again to restart.

Clear Clears the graphing screen. Same as selecting Clear Screen from the View 
menu.

Zoom in Zooms in on the current grid using the default scale factor. This is the last scale 
factor you entered using the Scale command. (When you start Graphmatica, the
default scale factor is 2.) This allows you to do the same thing as calling up the 
Scale dialog box and pressing OK with one mouse click.

Zoom out Zooms out on the current grid using the default scale factor. Similar to the 
Zoom in button above.

Range Lets you select a new range to show using the mouse. This is NOT the same as 
selecting the Range menu option. First select the area you want to see with the 
mouse by holding down the left button and enlarging the rectangle. Since the 
computer is better at maintaining a square aspect ratio than you are, you don't 
have to worry about doing this perfectly. Depending on how you draw the 
rectangle, either the top or bottom y-coordinate will be AutoScaled. If you start 
from the bottom and draw up, the bottom coordinate will be fixed and the top 
one ignored and computed automatically. If you draw downward, the top 
coordinate will be fixed and the bottom one AutoScaled. When you have 
selected an area, click on the Range button to redraw the grid. Graphmatica 
will display the exact coordinates of the new range on the status line. If you do 
not click the Range button, the selection will be forgotten as soon as you click 
the mouse in the graph window,    clear the screen, draw another graph, or make
a new selection.

Redraw all Same as selecting All Graphs from the Redraw menu. Draws every graph in the 
queue.

Default grid Sets the grid back to Graphmatica's default of -8 to 8 and AutoScaled y 
coordinates. This is useful if you have selected a weird range that is really large 
or small, not centered, or not squared and you want to quickly resize the grid to 
reasonable, centered proportions.



DRAWING A GRAPH
Once you have successfully entered an equation, Graphmatica will proceed to draw it. If 
warning messages are on, any non-fatal errors that are encountered will be displayed in the 
status bar. If you want to pause the graph at any time,    just click the Pause button, or press 
ESC or enter on the keyboard. Graphmatica will display the message

Pause at var1=value1, var2=value2. Press ESC to abort or enter to restart...
which displays the current values of the variables in the equation. Since Graphmatica cannot
start a new task while it is in the middle of drawing a graph, while you are pausing you have 
only two options: turn off Pause and continue graphing by Clicking the Pause button again or
pressing enter, or abort the graph by clicking the ABORT button or pressing ESC. You may 
find that you prefer using the keyboard to clicking the pause button with the mouse, 
because the response time is somewhat better (i.e. graphing will actually stop sooner) when 
the computer doesn't have to do the 3-D pushbutton effect.

You may work on other applications while drawing or pausing a graph, but Graphmatica will 
not respond to anything but pause, restart, and abort requests. (It may look like you can 
select menu items, but they will not be executed. In fact, drawing will stop while you are in 
the menu, so don't waste your time trying make Graphmatica do anything else while it is 
graphing.) You may also move or minimize and restore the Graphmatica window. Do NOT, 
however, attempt to resize the window while you are graphing. Although Windows will not 
try to stop you, Graphmatica will ignore any attempts to resize the window as this would 
likely change the size or shape of the grid and render any points already plotted invalid. This
will result in a grid which does not fit the size of the window (if this happens, just minimize 
and restore the window once graphing is completed and Graphmatica will recalculate the 
screen size properly).

When the graph for your equation is complete, the status bar will change from "Graphing: 
xxx" to "ON SCREEN: xxx" to indicate drawing is done. Also, the pause button will be 
dimmed and the other buttons in the button bar re-enabled. If you'd like to start all over with
a completely different equation, just start typing (the last equation is automatically selected 
in the edit field so the text is automatically cleared once you start typing). If you'd rather 
modify the last equation, click the mouse or press a direction key to turn off the selection 
and then go right ahead; it's already stored safe and sound in the redraw queue (for more 
information see The Redraw Queue). Or you can modify any previously entered equation by 
using the up and down arrow keys to scroll forwards and backwards in the redraw queue, 
respectively. (Clicking the mouse on the down arrow icon to the right of the graph prompt 
drops down a scrolling listbox from which you can view and select equations with the 
mouse.) You can also use this "scroll back" capability to redraw a graph that is in the queue 
but not presently on the screen: just select the equation you want and press enter or click 
the Graph button. 

If you want optimum performance and you are not running any timing-sensitive applications 
(e.g. communications programs doing background file transfers), you can use the Hog CPU 
option to prevent Graphmatica from yielding the processor to other applications while it is 
graphing. See Hog CPU option for details.

Since you can draw as many graphs on the same grid as you want, Graphmatica does not 
provide for having multiple grids on screen at the same time. However, if you would prefer 
to look at two graphs side-by-side instead of superimposed, just run two copies of 
Graphmatica next to each other. (You can share data between them by saving and loading 
equation lists.)



Normal Cartesian equations
Graphmatica's equation parser will automatically isolate the variable "y" wherever it is in the
equation. It will graph some relations, like circles ("x^2+y^2=36") and ellipses ("x^2/3 + 
y^2/4 =20"), as well as hyperbolas, sideways parabolas ("x=y^2") and many other conic 
sections. (Consult a good Algebra II textbook for help on their formulas, as I'm a little rusty.) 
The only limitation for functions is that there must be one and only one occurrence of the 
variable "y". Graphmatica cannot graph an equation without a "y", like "x=4". It also cannot 
perform the factoring needed to isolate the variable "y" when it occurs more than once (i.e. 
"x=y^2+3y"). The relation graphing module (for graphs which may have more than one y-
value for a given x value) works like this: if in isolating the "y" in an equation Graphmatica 
finds an even power of it (i.e. "y^2"), it makes two equations for that graph, one with the 
positive and one with the negative root. This method by no means covers all possible 
relations, but it is adequate for the most common. In fact, I haven't thought up an equation 
it can't graph yet.



OPERATORS
Graphmatica uses an operator set almost identical to BASIC's, with several additions to 
make it more user-friendly. Almost all of the math functions provided in the Microsoft C 
library have been made available. The supported operators and functions are as follows:

Operator/Function Meaning
=================

=======================================
+, -, *, / Add, subtract, multiply, divide
^ Exponentiation
[( )] Parentheses: may be nested to any extent,

brackets are provided for ease of reading but
parser WON'T differentiate between "(" and "["

; (semicolon) Separate halves of a parametric equation
' (single quote) Make rest of the equation a comment
{ a, b } Specify domain, where 'a' is the start of the

domain and 'b' is the end. Either end may be
left open by omitting 'a' or 'b'.

abs absolute value
acos, asin, atan arc cosine, arc sine, and arc tangent
asec, acsc, acot arc secant, arc cosecant, and arc cotangent
cos, cosh cosine and hyperbolic cosine
csc cosecant
exp Euler's number to the specified power
int greatest integer ([x] is not supported)
ln, log natural logarithm, logarithm base 10
sin, sinh sine, hyperbolic sine
sec secant
sqr square root
tan, tanh tangent, hyperbolic tangent

NOTE that all trig functions work in RADIANS, not degrees.

Besides the variables x, y, r, t, and dx,    2 constants (pi [3.14159...] and e [Euler's number: 
2.718...]) are legal identifiers for your convenience.



ENTERING EQUATIONS
There are few restrictions on the form of your equations, and those are probably pretty 
familiar to you if you have ever worked with BASIC.

Your equation must include: *
+ exactly one dependent variable ("y" or "r")
+ exactly one equals sign ("=")
+ some sort of expression on each side of the equals sign

The rest is up to you. You can also include:
+ as many instances of the independent variable ("x" or "t") as you like, or none.
+ constants (decimal numbers and "pi" and "e" are valid)
+ basic math operations (+, -, *, / for division, ^ for exponents). Multiplication can be 

implied.
+ nested parentheses to any extent
+ trigonometric, exponential, and other functions
+ a domain, which may be open or closed on both sides
+ a comment, so you can make notes to yourself or others

(* Parametric equations, because they are inherently different from most others, have 
different requirements which are explained in detail in Parametric Graphing.)

For an exact list of these operators, see the Operator Table.

You must separate alphabetic identifiers with a space, paren, or an arithmetic operator. The 
parser's ability to determine exactly what you want to pass as an argument to a function is 
somewhat limited, so I suggest you make it a habit to enclose the desired expression in 
parentheses. "cos x" may work fine but "cos 2x" is interpreted as "(cos 2)*x" and "cos x^2" 
turns out "(cos x)^2". Typing "cos (2x)" or "cos (x^2)" instead works perfectly.

The order of operations is the standard algebraic left to right of:
Functions
Parentheses
Exponents
Multiplication and division
Addition and subtraction

Graphmatica supports implied multiplication of variables and constants as in "3x" or 
"5(2x+3)", but not of variables and other alphabetic identifiers such as functions and built-in
transcendental numbers like "xx", "xcos(x)", or "xpi", so you must include the times sign in 
those cases. (Implied multiplication of the two variables x and y [e.g. "xy=1"] is supported, 
however.) The parser may reject some complex expressions for no apparent reason. Keep 
trying! I suggest liberal use of parentheses: if you are not sure whether something will be 
interpreted correctly, go back and put parentheses around it. (However, you should not use 
parentheses gratuitously; the best example of this is that if you enclose the entire 
expression on either side of the equals sign in parentheses, the parser will NOT be able to 
find the expression inside.)

For brief or in-depth information about each of the types of graphs Graphmatica supports, 
read the Overview of Graphing Techniques.



SPECIFYING THE DOMAIN
Graphmatica allows you to specify the domain of each equation independently. This allows 
you to draw only a particular part of a graph or change the domain without using the Range 
or Theta range functions to change the default domain. To specify a domain for an equation, 
type anywhere on the line the expression

{ a, b }
where 'a' is the start of the domain and 'b' is the end. If you want the domain to start at the 
default start, leave 'a' out. Then, whatever you change the start of the default domain to, 
that will always be where the equations starts graphing. To leave the end of the domain 
open, leave out 'b'. So if the range on-screen is (-10,10), specifying a domain of "{ ,5}" will 
graph from -10 to 5, and one of "{-4, }" will go from -4 to 10.

To graph a parametric equation, you MUST specify a domain that is closed (i.e. one that has 
neither number left out).

For ease of use for polar graphs or trigonometric functions, you can specify the domain as 
multiples of pi by typing '###p' and degree measures instead of radians by typing '###d' 
(see Polar Domains).



ERROR MESSAGES
Fatal Errors occur when either the parser of the evaluator cannot make sense of and 

expression you have typed in. They are presented in a popup message box and require 
you to edit your equation.

Warning Messages are errors encountered trying to evaluate specific point(s). By default 
they are not displayed but you can toggle this with the Warnings Option.



FATAL ERROR MESSAGES
Twelve error messages may be encountered when graphing (apart from messages ingrained 
in the library functions which I cannot control). Six of them are fatal; the equation cannot be 
graphed and you must edit it. They will present a popup message box so you know there is a
problem. The other six apply only to specific point(s) for which a y-value cannot be 
generated. They will not appear unless you ask for them using the Warnings option and then
they appear silently.

[Please note that all warning messages which refer to the variables 'x' or 'y' will actually be 
't' or 'r' when you are dealing with a polar equation.]

"Found bad operation or mismatched parentheses. Press any key to retype..."
You either left out a paren somewhere, left out one or both of the operands for a binary 
operation or the argument for a function, or typed some other weird thing the parser and
evaluator couldn't digest, like putting parentheses around the entire expression. Examine
your equation carefully and fix whatever seems to be the problem.

"Found unknown identifier. Press any key to retype equation."
Unfortunately, the evaluator isn't set up to return what caused the error, so you'll have to
look for it yourself. Check that your equation contains only valid identifiers (x, y, pi, e, r, 
t, and the functions listed in the Operator Table) and that you separated each of them 
with an operator, space, or some other punctuation.

"No equals sign or more than one found. Press any key to edit equation."
To be a valid and graphable, your equation must include exactly one equals sign ['=']. If 
you get this error, you either left out the '=' or accidentally typed two or more of them. 
For parametric equations, there must be an '=' on each side of the dividing ';'.

"No 'y' variable or more than one found. Press any key to edit equation."
Although Graphmatica has been enhanced to isolate ONE 'y' variable and graph some 
relations, it cannot graph an equation without a 'y', like "x=4". It also cannot perform the
factoring needed to isolate the variable 'y' when it occurs more than once (i.e. 
"x=y^2+3y"). If you can adjust the equation so it uses only one 'y', do so; otherwise it 
can't be graphed. In parametric graphing, this message may also indicate that no 'x' 
variable was found in the x(t) equation.

"Can't find the inverse of this function of y. Press a key to edit equation."
You tried to graph an equation like "int(y)=x" or "abs(y)=x" for which y cannot be 
isolated by taking the inverse of the function. The functions which cannot be isolated are 
"abs", "cosh", "sinh", "tanh", and "int". If you can't adjust the equation so this error does 
not occur, it is not graphable.

"Parametric equation requires that you specify domain! See Parametric Graphing in help file 
for details."

You typed in a parametric equation (or accidentally hit the semicolon) and neglected to 
include a closed domain [like {1,6}]. Because the diversity of parametric equations 
makes it hard to pick a default domain, you have to include one with each parametric 
graph. [See Parametric Graphing or Specifying a Domain for more help.]

See also Warning Error Messages



WARNING ERROR MESSAGES
"Overflow at x=#.##."

Some function or operation generated a number too large to fit into a 8-byte floating 
point variable. The point at x=#.## was not graphed. This error is not fatal, so the 
graphing process is continued, but if the message is repeated and no image is graphed, 
you may need to abort graphing and look at your equation again.

"Division by zero at x=#.##."
At x=#.## your equation included division by zero so that point was skipped. Unless you
get this error repeatedly, there's no real problem.

"Can't raise a negative number to a fractional power. [x=#.##]"
Due to the possibility of getting an even root of a negative number (like -16^(1/2) which 
actually equals the square root of -16), the C Library pow() function refuses to process 
any arguments like these. This is not a fatal error, and the portion of your graph (if any) 
where the base is not negative or the power is not fractional should be graphed perfectly.
This error also occurs when you try to take the square root of a negative number with the
"sqr" function.

"Can't find the logarithm of a negative number. [x=#.##]"
The natural logarithm (ln) and base 10 logarithm (log) functions are defined only on x 
greater than zero.

"Domain error: asin/acos defined only on -1<=x<=1, acsc/asec on x<-1,x>1. [x=#.##]"
The arcsine (asin) and arc cosine (acos) functions are only defined between -1 and 1 (the
range of the sin and cos functions). The asec and acsc functions are only defined outside 
this range.

See also Fatal Error Messages



INTRODUCTION TO POLAR GRAPHS
Polar coordinates are a fundamentally different approach to representing curves in two-
dimensional space. The concept is pretty easy to grasp graphically, but if you have never 
used polar coordinates and want to understand them, you should probably read the section 
below.

The traditional Cartesian method relies on an x and a y coordinate to mark how far a point is
from the axes in two perpendicular directions; polar coordinates plot the location of a point 
by one coordinate represented by the Greek letter theta which is simplified to "t" in 
Graphmatica and another called "r". The "t" tells what direction to go in from the origin, and 
the "r" tells how far to go out in that direction to reach the point. The direction is measured 
in radians as an angle starting from the positive side of the x-axis and turning around 
counter-clockwise (like measuring the angle the hand on a clock has traveled starting at the 
3 o'clock position and going backwards). There are 2pi radians in a complete circle, 
corresponding to 360 of the degrees you're familiar with. To put a polar coordinate into 
Cartesian terms in order to graph it, we use the equations: x = r cos t    and    y = r sin t.

To make a graph using polar coordinates, we let theta be the independent variable and 
calculate a distance to plot out from the origin as we let the angle sweep around in the 
positive direction. The domain for the graphing is 0 to 2pi (the first complete circle in the 
positive direction), but you can easily change these values using the Theta Range function in
the View menu. Polar graphs can be entered from the "Graph?" prompt just like normal 
graphs. The only difference in what you type, and the way Graphmatica detects a polar 
graph, is that you must use the variables "t" and "r" instead of "x" and "y". The restrictions 
are still the same: you can have one and only one instance of the dependent variable "r," 
although it can be located almost anywhere in the equation. You can embed the "r" in a term
like "r^2" to graph functions that cannot be simplified by normal means and Graphmatica 
will evaluate both positive and negative roots automatically. You should watch as your graph 
is drawn, because often the direction it is going is almost as important as the figure it draws.
(When you have a "double" equation with "r^2" in it, though, note that the positive roots are
drawn first and then the negative roots are drawn: theoretically they should be drawn 
simultaneously but this is not practically possible.)

Please note that the x and y coordinate ranges and the range for the variable theta function 
completely independently; in normal Cartesian graphing, theta's value is irrelevant, and in 
polar graphing, theta controls the domain of the graph, but the x and y ranges still control 
the physical screen you see. If you want to change your view of a polar graph, you use the 
scale or range functions just as you would normally.

See also Specifying Polar Domains for details on how to specify an angular domain.



INTRODUCTION TO PARAMETRIC GRAPHS
Parametric graphing, like polar graphing, uses a different method of calculating points on the
plane to come up with curves that may be difficult to compute using normal rectangular 
coordinates. They are unique in that the Cartesian x and y coordinates are calculated based 
on a third variable (the "parameter" of x and y) which is traditionally called 't' (not to be 
confused with the 't' used by Graphmatica to represent theta). T is allowed to increase from 
the start of the domain you specify to the end. At each value, the functions x(t) and y(t) are 
calculated to give an (x,y) coordinate which is graphed. Graphmatica then connects these 
points to form a smooth curve--if something you graph begins to look jagged, you probably 
need to adjust the fineness. (Parametric graph fineness is linked to the same fineness 
control as Cartesian and polar graphing, and should be decent at the default fineness value, 
but if you need to, you can increase or decrease this value. Be aware that this will affect the 
fineness of non-parametric graphs as well. See Adjusting the Fineness for details.)

To enter a parametric graph, you need to remember four basic parts: the x(t) and y(t) 
functions, the semicolon between them (this is how Graphmatica knows it's a parametric 
graph), and the domain for t.

semicolon
 x-function |            y-function domain
                |            |                      | |
  x = 2t ;  y = 2t^2 {-10, 10}

Although as in all other Graphmatica equations you don't need to solve for x and y (i.e. t=5x
would be OK), only one x and one y can appear in the whole equation, and "double" 
equations like "x^2=t" where Graphmatica would normally solve for both the positive and 
negative roots are NOT supported (you can enter them but only the positive root will be 
found; each equation in the redraw queue is allowed enough space to hold two computable 
expressions, and either a double equation or an x/y pair of parametric equations will fit, but 
not both). You can type the x and y equations in either order, as long as they are separated 
by a semicolon, and the domain will be recognized anywhere on the line. You MUST specify a
domain for each parametric equation! The variety of curves that can be drawn with 
parametric equations is great and makes choosing an appropriate default domain 
impossible. Some curves (like those including the circular functions sine and cosine) tend to 
work best over a {0,2pi} domain, like polar graphs. Others will match up better with the 
default domain of the normal graphs, the size of the viewing area. Some have a very 
compact domain, between say 0 and 1, where they will appear on the screen. If you over- or 
under-estimate the domain, you can always abort the graph and edit your equation.



DIFFERENTIAL EQUATIONS
Graphmatica also has built-in a rudimentary feature for approximating the solutions of first-
order differential equations. [I will not provide background material on this function because 
if you need to use it, you probably know more about differential equations than I do.] To let 
the parser know you want to graph a differential equation, you must include the differential 
"dx" as one of your variables.
If you specify an equation as

dx = f(x,t)
where f(x,t) is some combination of the variables x and t (such as "x^3 + t" or "t * x" ) and 
do NOT include the domain operator { , }, the program will draw a slope field for dx/dt = 
f(x,t).

If you do include the domain operator {a, b} , however, it will not be interpreted as a 
domain but will instead indicate that you want to graph a specific solution to the initial-value
problem x(a)=b  by Cauchy-Euler approximation. This deviation from the normal notation is 
only valid for differentials.



OVERVIEW OF GRAPHING TECHNIQUES
Graphmatica offers the following methods for graphing equations. Each method is detected 
automatically by the use of distinctive variables.

Normal Cartesian (rectangular) Graphs Typical graphs like "y=x^2" including only the 
variables x and y. Also includes relations like "x^2 + y^2 = 36".

Polar Graphs      Graphs using the polar coordinate system and the variables r and t (for 
theta). 
Example:    "r=cos t"

Parametric Graphs      Graphs using the rectangular coordinate system but specified by 
equations of a third variable or "parameter," t. These graphs must include a domain. 
Example: "y = sin t ; x = cos t {0, 2p}" draws a circle.

Differential Equations      Graphs used to approximate solutions to first-order differential 
equations; use variables dx (for the differential dx/dt), x, and t.
Example: "dx = x^2 + t" plots a slope field for "dx/dt = x^2 + t."

Graphmatica comes with pre-defined equation lists demonstrating each of these graph 
types. See Demo Files for details.

While some curves can be drawn by Cartesian relations, polar coordinates, and parametric 
functions, each technique is better suited for some graphs than for others. For instance, a 
circle with radius 5 around the origin which can be produced by the equation

x^2 + y^2 = 25
can be drawn faster by the parametric equations

x = 5 cos (t) ; y = 5 sin (t)    {0, 2p}
and can be drawn faster and much more simply by the polar graph

r = 5.



USING AutoRedraw
Whenever you change the scale to look at a graph in greater detail or from farther back, or 
you shift the range of the axes so that the graph you just drew will be centered, the screen 
must be cleared so that a new coordinate grid can be drawn. So you're left with the viewing 
angle you wanted for that graph, but the screen is blank. You shouldn't have to solve this 
problem by retyping the equation...and you don't. You can redraw the equation much more 
easily by selecting Last Graph in the Redraw menu. But with AutoRedraw ON, you don't even
have to do that.

As its name suggests, AutoRedraw will redraw the last equation(s) you typed in 
automatically when you change the scale or range. If you don't want a graph redrawn, you 
can abort it by pressing ESC twice. If you want to turn off AutoRedraw completely, just select
AutoRedraw under the Options menu.

You can also change the number of equations AutoRedraw draws. Do this in the Options 
Settings dialog box. This can be anything from 1 to 25, the maximum number of graphs. If 
this number is greater than the number of equations in memory, all of them will be redrawn. 
The default is 1.



THE REDRAW QUEUE
Every time you type in an equation, the character string you typed and the program's 
internal representation of that equation get stored in the redraw queue. From this queue, or 
list, you can call up any of the last 25 equations you typed to graph again with fewer 
keystrokes than retyping it. Or you can redraw all of them or the just the last one you typed 
with even fewer keystrokes. The equations in the queue are stored in an order that puts the 
most-recently-used at the beginning and the least-recently-used at the end. Hopefully, when
the queue fills up, the equations that are bumped off the queue at the end will be the ones 
you won't miss very much.

The screen clears whenever you execute a Range or Scale command. If you execute either 
of these functions or clear the screen accidentally with the Clear menu option, you can 
redraw the last equation (if AutoRedraw hasn't already) by selecting Last Graph from the 
Redraw menu, or you can redraw all of the equations in the queue using the Redraw All 
menu option or button. Note that the redraw all function does not care which graphs were on
the screen before it was cleared; it just redraws all the graphs in the redraw queue that are 
not currently on the screen. If you cleared the screen manually, and have not changed the 
size of the grid before you choose Redraw All, Graphmatica will detect which graphs have 
already been calculated using that grid and redraw them without recalculating their points 
(this is much faster than plotting the graph from scratch).

You can scroll through every equation you have entered into the redraw queue using the 
combo box at the top of the screen. When you select an equation using the arrow keys or 
mouse, Graphmatica displays its current status (on or off screen) and the text of the 
equation in the same color the graph was drawn in at the bottom of the screen in the status 
bar.    Press the down arrow key or pull down the listbox with the mouse to scroll back one 
equation. Press the up arrow key or button to scroll back up the list if you want to. When you
have found the equation you want, press enter or click on it and press enter or click the 
Graph button (do not modify the equation) and the graph will be redrawn. Afterwards, the 
equation will be displayed for editing, except now it is at the head of the queue.



DELETING AN EQUATION
 
If you enter an invalid equation that can't be graphed, Graphmatica will automatically 
prevent the equation from being added to the redraw queue. However, if you want to trim 
unwanted equations from the redraw queue before saving an equation list or for any other 
reason want to delete an equation that is already in the queue, just do the following:

1. Using either the down arrow key or the mouse, select the equation you wish to delete 
from the redraw queue combo-box. DO NOT attempt to select the equation by retyping it 
in the edit field.

2. Either select Delete Equation from the Redraw menu or click on the "Delete" button on 
the button bar at the top of the screen.

See also Clearing the Redraw Queue for how to clear the entire redraw queue at once.



CLEARING THE REDRAW QUEUE
To clear the entire redraw queue, simply select Clear All from the Redraw menu. All the 
equations in the queue will be deleted.

See also Deleting an Equation for how to remove a single equation from the queue.



SAVING SETUP INFORMATION 

You can save your preferred grid size and settings of other user options so that whenever 
you run Graphmatica again they will automatically be restored. You can do this at any time 
by selecting the Save Setup Info item in the File menu. The options will be saved in the 
GRAPHMAT.INI file in the current directory. If this is not where the program files are stored,
Graphmatica will not be able to find it again, so if you change the directory using the load or 
save list commands, be sure to reset it before you save the setup (or be prepared to copy 
this file into the proper directory).

The setup file is just a special equation list that is loaded automatically when you start 
Graphmatica. It follows the exact same format as a normal equation list (described in Editing
Equation Lists) except that when you save it Graphmatica leaves out the labels and the 
equations (the important parts of normal equation lists). If you do want to save equations 
and labels in it, use the normal save command (with the Save setup option checked), and 
just enter the filename GRAPHMAT.INI.

When Graphmatica saves your options, to simplify things it only records those options that 
are different from its own internal defaults. (See Default Settings for a list of these.) If    your 
settings are close to the defaults, your setup file will be very short.



SAVING AND LOADING EQUATION LISTS
To save the list of equations you're working on, as well as the title and y-axis labels if you've 
entered them, simply select Save from the File menu and enter a filename. This file will be 
saved in the current directory with an extension of ".GR" (for GRaphmatica) unless you 
specify differently. You can also use the list box to change the directory before saving. If you 
want to save the current grid and special options along with the file (these are then 
automatically re-instated when you load the file), mark the "Save setup information too" 
checkbox.

To reload your list of equations or load up one of the demo files provided with Graphmatica, 
you have more options. You can automatically load a file when you run Graphmatica by 
typing its name (with or without a file path or the ".GR" extension) as a command-line 
argument (or associate ".GR" files with Graphmatica using the File Manager. Then those 
equations will be loaded up (and graphed) immediately, unless the file contains options 
specifying AutoRedraw off. You can also load an equation list at any time by selecting Load 
List in the File menu. Select the file you want from the list box (directories are included at 
the end of the file list so you can search for files anywhere on the disk).

After you select a file to load, if the redraw queue is not empty, you must decide whether to 
add the new file's equations to the existing queue or replace its current contents. Check the 
"Clear old equations from queue" box to do so. Also, you can select whether or not you want 
to draw all of the equations you have just loaded immediately [the default is to do so] using 
the "Redraw all after load" checkbox.

The graph title and Y-axis labels (if the file had any) that were loaded will also be displayed if
the Labels Always On option is selected.

If the file was saved with the Save setup option on, the grid and special options settings 
recorded in the file will be loaded and set automatically.



EDITING EQUATION LISTS and graphmat.ini
 
Graphmatica does not really provide facilities for maintaining equation lists; although you 
can edit an equation, delete old ones that are no longer needed, and change the order of 
equations by redrawing selected graphs, determining the precise order of equations in the 
list is difficult since they are dynamically shuffled each time an equation is entered or 
redrawn to make Graphmatica more interactive. However, the equation list is just a text file 
whose structure is virtually identical to the win.ini file, you can create or modify one with 
virtually any editor. The structure goes like this:

[labels]
title = xxxx any character string
left = xxxx
right = xxxx

[grid]
left = #.## any decimal number
right = #.## or "auto" to autoscale
top = #.##
bottom = #.##

[options]
autoredraw = on or off "on" or "off"
autonum = ## any integer 0-25
legends = on or off
hogcpu = on or off
mono = on or off
autosquare = on or off
labels = on or off
tables = on or off
warnings = on or off
defscale = #.## any decimal number
fineness = #.##
tstart = #.##
tstop = #.##

[equations]
up to 25 equations, each up to 80 characters, each on a separate line.

The [labels] section specifies the title and y-axis labels. The [grid] section gives the left, 
right, top and bottom coordinates of the grid. Type "auto" for any one to auto-scale that 
coordinate based on the other three. Type auto for both the top and bottom to auto-scale the
y-axis so the top and bottom coordinates are equal and opposite.

You can omit any item or even a complete section if you don't want to change the default. 
Type    exactly as specified above, including the brackets "[ ]"    around the section headings, 
and replacing the underlined portions with your own values. If you don't know or don't care 
what the value is for an option, just leave the line out. Don't worry about capitalization, extra
spaces, or even extra blank lines. (However, each entry must be on a separate line or some 
may be ignored.) You can put the options and sections in any order ... the only requirement 
is that the [equations] section must come last, if there is one. Invalid options are also 
ignored.

If you want to create a file with no titles or options, simply type the "[equations]" header and
then type all of your equations. Each equation must be on a separate line. There is one 
catch, however: since Graphmatica graphs the most recently entered equation first when it 



redraws, when the list is loaded and graphed, the equation listed LAST will be graphed 
FIRST. (It is certainly possible to correct this situation by graphing the equations as they 
come in, but then every subsequent "redraw all" command would draw the list backwards 
anyway.) If you load an equation list and immediately save it without changing anything, the
net effect will be that the order of the equations in the file is reversed.

The graphmat.ini file, which is loaded whenever you run Graphmatica without specifying an 
equation list to load, uses the exact same format... when you choose the Save Setup Info 
command, Graphmatica simply saves the setup file as it would an equation list, except the 
[labels] and [equations] sections are omitted, since you probably don't want to have the 
same graph title and equations load up automatically forever and ever.

To convert equation lists from Graphmatica for DOS version 2.80, load the file in any text 
editor and make the following changes: [Graphmatica for DOS version 3.0 files are identical 
to Windows files.]

If there are titles in the file, add a [labels] header to the top, insert a title= before the 
first line, left= before the second, and right= before the third.

Insert a new line and type the [equations] header line before the equations.

That's it. You can now load the file up in Graphmatica and resave it with the save setup 
option to save a specific grid or other options along with the equations.



CLEARING THE SCREEN
Since Graphmatica allows you to superimpose one graph on top of another indefinitely, after
a while the grid may be a huge mess. At this point you might want to select Clear in the 
View menu to clear the screen. Everything will be erased and the grid will then be redrawn. 
Remember, every equation you have typed is still stored and can be redrawn later even 
after you have cleared the screen.    In fact, every graph that was on the screen prior to 
clearing can be recalled instantly and will not even need to be recalculated until the grid size
changes.

You can also clear the screen using the "Clear" button on the button bar.



CHANGING THE SCALE
The scale function allows you to change the scale of the graph you have on-screen while 
keeping the center of the display the same (the origin may move but if (2,2) is at the middle 
of the screen, it will stay there). The scale is totally relative to the size of the grid that is 
presently on the screen, so you need not make any comparison with an absolute scale of 1. 
To rescale the grid, select Scale from the View menu. Then respond to the prompt according 
to the following guidelines:

Enter a positive number greater than one to specify the amount to zoom (the "scale factor"). 
Then select the appropriate radio button to zoom in or out and press the OK button. 
Zooming in by a factor of 2 halves the width and height of the grid. Zooming out by a factor 
of two makes the grid twice as wide. (In the new Camcorder-age terminology, zooming in 
acts as a telephoto and zooming out as a wide-angle lens.)    Scale factors less than 1 are 
invalid because they produce meaningless values. Decimals greater than 1 are valid though 
(e.g. 1.05 changes the dimensions of the screen just slightly).

The scale factor you enter is remembered for future reference and presented as the default 
the next time you scale the grid. Also, this default value is used when you press the Zoom 
in and Zoom out buttons on the button bar so that you do not need to specify a new scale 
factor. The default value upon startup is 2.



ADJUSTING THE RANGE
The ability to adjust the grid by inputting the beginning and end of the desired range is one 
of the most powerful and flexible features Graphmatica offers. It can rescale the grid to 
either be a perfect fit for the function you are graphing so that as much of it is visible as 
possible or to render the most accurate image possible. Both of these features can be 
accomplished by selecting Range in the View menu.

To create a grid such as the first, graph an equation on the standard grid, and from that 
graph determine the top-, bottom-, left-and rightmost extremities of the graph, and enter 
these values in the appropriate edit fields. The new grid may be somewhat expanded or 
compressed depending on the aspect ratio, but it will show the same amount of graph in 
much greater detail.

To create a more accurate representation like the second grid, roughly determine 3 of the 4 
coordinates (left, right, top, or bottom of the grid). Enter these 3 numbers, and clear the 
fourth field entirely by selecting the contents and deleting or just pressing backspace. Now 
mark the "Autoscale fourth coordinate" checkbox. The coordinate you did not specify will be 
AutoScaled to the exact y to x ratio needed to make the grid look square.

You can also easily select a new range using the mouse and the Range button in the Button 
Bar. First select the area you want to see with the mouse by holding down the left button 
and enlarging the selection rectangle. Since the computer is better at maintaining a square 
aspect ratio than you are, you don't have to worry about doing this perfectly. Depending on 
how you draw the rectangle, either the top or bottom y-coordinate will be AutoScaled. If you 
start from the bottom and draw up, the bottom coordinate will be fixed and the top one 
ignored and computed automatically. If you draw downward, the top coordinate will be fixed 
and the bottom one AutoScaled. When you have selected an area, click on the Range 
button to redraw the grid. Graphmatica will display the exact coordinates of the new range 
on the status line. If you do not click the Range button, the selection will be forgotten as 
soon as you click the mouse in the graph window,    clear the screen, draw another graph, or 
make a new selection. Note: If you turn the AutoSquare option OFF,    your selection will be 
taken literally, and the grid drawn without AutoScaling any coordinates, regardless of the 
effect on the aspect ratio.



AXIS LEGENDS
 
By default, Graphmatica labels the hatch marks across the graph with the number of their 
coordinate so that you can more easily locate points or find the coordinates of a graphed 
point. In some cases, though, especially when doing graphs near the axes, the numbers can 
be confusing and you may want to turn them off. To do this, either select the Legends option
in the Labels menu or mark the checkbox in the Settings dialog box under the Options 
menu. To turn the legends back on, select the Legends option again. 



ADDING A TITLE TO YOUR GRAPH
 
If you want to add a title line to your graph, or add labels to the left or right sides, select 
Title from the Labels menu.    You can type in a new title, edit one you typed in previously, 
When you print, the title is written across the top of the graphs, and it is automatically 
centered. When you are graphing, unless you have selected the Always On option in the 
Labels menu, the labels are not shown.

Graphmatica can add text labels (regular printing going down instead of across) to both 
sides of your graph.    Like the title, these labels are automatically centered (vertically) on 
the graph.

Click the Clear All button to delete all three fields. If you do this by mistake, just Cancel the 
dialog box and the labels will not be affected.

Unless the Always Draw Labels option is on, Graphmatica does not draw these labels 
immediately, since they are intended mainly to enhance hardcopy printing and no space is 
reserved for them on the screen.



LABELS ALWAYS ON OPTION
Selecting the Always On option from the Labels menu or marking the "Always Draw Labels" 
checkbox in the Settings dialog box makes Graphmatica always leave space on the screen to
display the graph labels (title and left- and right-side), as well as display them if you have 
entered any. When this option is on, the labels will also be copied to the clipboard along with
the grid whenever you perform an Edit Copy Graphs or Copy Graphs Mono command. (By 
default they are ignored except when you are printing.)



THE DEFAULT SETTINGS
 
When you first run Graphmatica without a graphmat.ini file, the following settings are in 
effect. Using the Defaults button in the Range, Theta Range, or Settings dialog boxes resets 
the options to these "factory" settings.

OPTION DEFAULT
Grid Range Start (-8.0, ___*)

End (8.0, ___*)
Fineness 1.0
Legends ON
Always Draw Labels OFF
Warnings OFF
Print tables OFF
AutoRedraw ON
# of equations to redraw (AutoNum) 1
Hog CPU OFF
Monochrome OFF
AutoSquare ON
Theta Range 0 to 6.28 (2pi)
Default Scale Factor 2.0

Title, left, and right labels are cleared by default.

* Y ranges vary to provide a square aspect ratio; they are by default equal and opposite.

This provides a basic rectangular grid of decent size with the origin centered, a square 
aspect ratio (a 1x1 square on the grid really LOOKS square), and a good resolution graph.

VIEWING THE SETTINGS
You can quickly see the settings of the on-off options by seeing if they are checked in the 
menus. You can also look at almost all of the settings at once by selecting the Settings 
dialog box from the Options menu.



SETTINGS DIALOG BOX
The Settings dialog box in the Options menu allows you to control just about every option 
available in Graphmatica. Following is a description of its controls, from top to bottom:

Grid Rangedisplays the current range. The two coordinates are the lower-left and upper-
right hand corners. Click the Change button to call up the Adjust Range dialog 
box. Click the Scale button to scale the grid.

Theta Rangeshows the current domain of theta. Click the Change button to call up the 
dialog box to adjust this.

Fineness Factor    Displays the current fineness factor; type in a new one if you like.

Checkboxes:
Draw Legends along Axes

Mark to draw numbers indicating scale along the axes. On by default.
Print warning error messages

Mark to display warning error messages while graphing. Off by default.
Print point tables

Mark to show the Printout window and tables of points graphed while graphing. Off by
default.

AutoRedraw On--Draw Last ___ equations.
Mark the checkbox to turn AutoRedraw on. When it is on, you can also type in the 
number of equations you would like to redraw.

Always Draw Labels
Mark to keep title and y-axis labels on-screen all the time.

Hog CPU while graphing
Mark to "hog" the computer while graphing; increases performance at the cost of 
other programs that are running. Off by default.

Buttons:
OK Accept the current changes.
Cancel Forget the changes made in the Settings dialog box. If you changed the Grid 

Range or Theta Range, these changes will NOT be undone.
Defaults Set all the options to their default (as specified by Graphmatica, not your 

graphmat.ini file) settings. See Default settings for details. To reset the Grid 
Range and Theta Range, however, you MUST call up and use the Defaults 
buttons in their own dialog boxes.

Help Brings up this help screen.



CHANGING THE RANGE OF THETA
 
Because the independent variable (theta) in polar coordinates is fundamentally different 
from the 'x' of Cartesian coordinates, the Cartesian x/y ranges can only be used to 
determine the size of the screen and not the domain of the equation graphed for polar 
graphs. Although the default 0 to 2pi range is the typical range of theta used for most 
graphs that go on forever (like spirals) and some closed graphs (like circles), other graphs 
cannot be completely drawn in this range of theta. For instance, the figure-8-shaped 
"r^2=64cos(2t)", because it is undefined where the right half is less than zero, is missing a 
couple of spots unless theta's range is extended to -2pi to 2pi. To allow the greatest 
flexibility, Graphmatica allows theta's range to be changed independently of all other 
options.

To change the range, select Theta range from the View menu and enter the start and end of 
the range you want. For each end of the range, you can specify whether to use radians or 
degrees by marking the appropriate radio button. (The default is radians.) You can also 
specify that a number is given as a multiple of pi by marking the "x pi" box of each 
coordinate. 

You can reset the domain to the default (0.0 to 6.28) by pressing the Defaults button.

The Theta Range dialog box can also be obtained by pressing the Change button next to the 
Theta Range display in the Settings dialog box.

If you would rather not change the default domain but simply change the domain for a single
graph, see Specifying a Domain.



SPECIFYING POLAR DOMAINS
Although Graphmatica works exclusively with radians, you can enter a function of theta's 
domain in either radians, degrees, or radian multiples of pi. (Decimals are allowed, but no 
fractions can be entered.) To indicate a value is a degree measure, follow it with a 'd' (any 
numbers after the 'd' are ignored). To indicate it is a multiple of pi, follow it with a 'p' (again, 
'p' must be the last character in your response). A plain number will be understood to be 
regular radians. You cannot use both the 'p' and 'd' options at once, but it would be 
ridiculous to measure degrees in multiples of pi anyway. So, to give a function the domain of 
negative 2 pi to 2pi, you would type "{-2p, 2p}" following your equation at the graph 
prompt.



ADJUSTING THE FINENESS
 
The fineness factor determines how high the resolution of the graph will be, and in effect, 
also the amount of time it takes to complete the graph. The fineness factor of 1 is quite 
adequate in most circumstances. Although Graphmatica's SmartFineness III automatic 
fineness adjustment gives consistent quality and speed on just about any equation, making 
the manual fineness adjustment almost obsolete,    you can still manually control the 
fineness to fill the need for especially sharp graphs or for extra-quick renderings. 
SmartFineness automatically decreases the fineness when the point being graphed is not on 
the screen to speed up blank areas, then recovers automatically and backtracks to the spot 
where the graph comes on-screen again. It also varies the fineness with the slope of the 
equation being graphed--less when the slope is near-horizontal, greater when the slope 
tends toward vertical, so steep graphs are tracked more effectively. As the fineness is 
increased, more of the curve will be smoothed out, but remember that if you increase the 
fineness factor to 5, the computer will be slowed down to 1/5 its normal graphing speed 
under the load of all the extra calculations.

Fineness is also linked to the rate at which the angle is allowed to change in polar graphs, 
and both Cartesian and Polar graphs will be of comparable quality at the same fineness 
factor. Fineness is also linked to the step rate of parametric graphs; because they vary so 
much, it is harder to insure that all parametrics will graph well at the default fineness, but 
those that I have tested look fine.

When graphing differential equations (slope fields), the fineness factor controls the interval 
at which the hatch marks are drawn. If you use too high of a fineness value on this type of 
graph, you may not only get an awful mess on the screen, but also exceed the capacity of 
the data structure that records the points that were graphed for later redrawing. [At this 
point Graphmatica simply stops recording, so no harm can be done, but the graph will not 
redraw properly when the screen is repainted but not recalculated.]

To change the fineness factor, select Fineness from the View menu. You can either type a 
value in directly or use the scroll bar to select a value (the scroll bar is scaled in a 
logarithmic fashion so any distance to the right corresponds to the same increase in fineness
as the same distance to the left of the middle). Any value greater than zero is valid; the 
default value is 1.0. Theoretically there are no other limits on the fineness, and you can type
any value into the edit field you wish, but the scroll bar slider is limited to the reasonable 
range of about 0.2 to 6.    I would recommend not going below 0.25, as the image quality 
suffers and the graphs begin to look like modern art. Also a    factor greater than 5 can bring 
even a fast computer to a snail's pace.



WARNING MESSAGES
By default, the error messages which do not require the equation to be retyped are 
suppressed, because they slow down the graphing process, cover up the equation, and are 
somewhat annoying when you know the graph shouldn't produce any values in some area. 
(Also, it saves you the effort of specifying the domain for each equation.) If something goes 
wrong (e.g. the graph doesn't show up on screen when it should and the reason isn't readily 
apparent), you can turn on the warning messages (using the Warnings function of the 
Options menu) and redraw it to see what the problem is. You can use the same menu option 
to turn the messages off later.

See Warning Messages for a complete list of warning error messages.



MONOCHROME OPTION
If you are using a monochrome monitor that does not do gray scales well (i.e. a laptop 
computer's) and you have trouble finding your equations, you can select Monochrome in the 
Options menu to make Graphmatica draw only in black on a white background. Also, the 
messages in the status bar are only printed in black when this mode is on.

The status of the Monochrome option only affects what you see on the screen. It does not 
control output to the printer or the clipboard. You can copy either a monochrome or color 
bitmap at any time by selecting the appropriate option in the Edit menu. Color printing is not
supported at this time, so all printed output is monochromatic regardless of the state of this 
option.



Hog CPU OPTION
By default, Graphmatica acts like a good little Windows application and yields the 
computer's resources to other applications as Windows sees fit at all times, including when it
is calculating a graph. This can lead to performance degradation, especially if while graphing
you do something equally power-hungry like load up and recalculate a 200k spreadsheet in 
Excel. Also if another application starts a time-consuming task that cannot be interrupted, 
Graphmatica cannot continue to draw until that application yields control back. If you want 
to get lean and mean, check Hog CPU in the Options menu. With Hog CPU on, every time 
Graphmatica draws or recalculates a graph it will keep the CPU exclusively to itself and not 
allow Windows to process any messages from other applications until the graph is finished.

WARNING: This option should be used with discretion. While you are drawing a graph with 
the Hog CPU option on, NO OTHER APPLICATION CAN RUN, even while you are pausing the 
graph. If you are also running a timing-sensitive application like a communications program 
doing a background file transfer, that application will likely fail in the time it takes 
Graphmatica to calculate and draw a new graph (unless you have a very fast processor).



AutoSquare FEATURE
Since working in a window that can be resized means that not only the size but also the 
shape of the grid can change at any time, the coordinates of the grid must be managed 
dynamically to prevent unwanted effects on the aspect ratio (simply put, whether a square 
on the grid looks square or is actually "scrunched" one way or another into a rectangle). 
Graphmatica has a feature to handle this called AutoSquare.

Whenever you resize the window, turn the print tables option on or off, or turn the graph 
labels on or off, the dimensions of the grid rectangle change. To keep the grid square when it
matches the logical coordinates to the physical screen, Graphmatica keeps the logical width 
of the grid the same and figures out how much height must be added or subtracted to 
maintain good aspect ratio. It then divides this height difference by two and adjusts both the
top and bottom of the grid by that much. (This way, whatever point on the grid was centered
stays centered.)

The state of the AutoSquare option has several important side effects as well. When you 
save an equation list and include setup information, Graphmatica checks the AutoSquare 
option. If it is OFF, the dimensions of the grid will be recorded exactly. If it is ON, at least one
coordinate will be recorded as "auto" so that no matter what shape the grid is when you load
the file again, it will be squared correctly. (If the top and bottom coordinates are equal and 
opposite, they will both be saved as "auto" so they will be regenerated that way; if they are 
not, only the bottom coordinate will be saved as "auto". The x-coordinates are always saved 
exactly.)

When you select a new range using the mouse and the Range button, Graphmatica also 
refers to AutoSquare. If it is on, the height of your selection will automatically be modified 
before the new grid is drawn so that square aspect ratio is maintained. If AutoSquare is off, 
you're on your own.

AutoSquare is ON by default. You can turn it off by selecting it in the Options menu.

When you turn AutoSquare off, the coordinates of the grid will stay the same no matter what
size it is. However, this does not prevent the need to recalculate graphs before displaying 
them again, since to conserve memory graphs are remembered as a list of physical points, 
not logical coordinates. Future versions of Graphmatica may support translation of 
coordinates between different physical grids, making faster redraw possible (at the expense 
of quality), but not the present one.

The status of the AutoSquare option does not affect automatic coordinate calculation when 
loading an equation list that contains a [grid] section. If AutoSquare was on when the file 
was saved (or it specifies "auto" for either or both y-coordinates), the grid will be squared. 
Otherwise it will be drawn with the exact dimensions it had when saved, regardless of x/y 
ratio.



EDIT MENU OPTIONS
Copy Graphs copies the current graphing screen in color into a bitmap and places it into 

the clipboard. You can then paste it into virtually any paint program and do whatever you 
like with the image. (If you have a color printer and a paint program that can print in 
color, copy the image and print using the paint program if you want color hardcopy.)

Copy Graphs Mono prepares a bitmap of the graphing screen using only black and white, 
so you can import the image into a document and print it without a color printer.

Hint: for the best possible image quality, let Graphmatica size the bitmap for you instead 
of scaling it with the paint program or word processor. The copied bitmap will always be 
the same size as the grid shown on the screen, so if you want a large bitmap, maximize 
the window, or for a smaller size, make the window smaller.

Copy Tables copies all of the text in the Printout window to the clipboard. If the Print Tables 
option is not selected, this menu item is disabled.

Copy Equations copies the selected equation (or, if no equation is selected, all of the 
equations entered in the redraw queue) to the clipboard, from which you can paste the 
text into any Windows application.



PRINTING PICTURES OF YOUR GRAPHS
Graphmatica prints through Windows' Graphic Device Interface, which means that you 
automatically get the convenience of both Windows' almost universal printer support and 
spooled output from Print Manager which allows you to work while the printer is running. 
(Note however that Graphmatica does not provide specific support for color printers, 
plotters, or printing over a network, so although you may be able to get satisfactory output 
using these devices, you might want to export a bitmap using one of the Edit Copy 
commands to a program that does support them and print it there.)

Except for Super Draft printouts, everything Graphmatica prints is scaled to use as much of 
the page as possible. When printing in Proof quality, Graphmatica creates a new graph 
screen in memory that has the same logical size as the one on screen, but whose physical 
size uses the maximum number of pixels on the display (i.e. 640x480--a routine I wrote to 
use some printers' higher-resolution abilities failed to print text but will hopefully work by the
next release).    It then redraws all the graphs listed as being on-screen on that grid and 
sends it to the printer. When printing in Draft mode, Graphmatica redraws the current graph 
screen in black-and-white in memory, and then expands that bitmap to fill the width of a 
page (8 inches). This does not take as much time as Quality mode, since the graphs are not 
recalculated, but setting up the bitmap can still take 2 minutes or more (the actual printing 
may take even longer, but this is entirely dependent on your printer). The trade-off in quality
is that the smaller your grid on-screen is, the more it will have to be expanded to fill the 
page and the lower its resolution will be. The fastest way to print is Super Draft mode: 
Graphmatica does not manipulate the bitmap at all except to adjust the aspect ratio on 
printers that have fewer dots per inch in one direction than the other. Thus the printout will 
be faster because it is not expanded, although it will be smaller as well -- Super Draft 
printouts are dependent on the current size of the graph window.    It is not advisable to use 
this mode on high resolution devices (i.e. over 150 dpi), especially if the graph window is not
maximized, unless you literally want just a thumbnail sketch. If your printer has a lower-
resolution draft mode, use Printer Setup to select it prior to printing in Super Draft. (NOTE: 
besides being a silly idea in the first place, printing in Super Draft mode on a laser printer 
may fail and cause the error message "bitmap didn't print". If this happens, as it did to me 
inexplicably when I tested the Laserwriter II, just use another print mode.)

The grid in a Proof Quality printout will not necessarily look like the one on the screen. 
Although it will have the same dimensions, the grid markings and the legends along the 
axes may be placed at smaller intervals due to the increase in resolution. While you are 
printing in Proof Quality, Graphmatica gives you progress reports on which equation it is 
graphing using the status line.

To print, select Print from the File menu, then select the print quality you want (Draft is the 
default.) If you have trouble distinguishing between graphs and other markings on the grid 
on the printout, you may want to mark the "Draw graphs with wide lines" checkbox.    [This 
increases the width of the "pen" used to draw graphs from one pixel to two.] Then click the 
Print button.

You can abort any print operation by pressing Escape or clicking the cancel button in the 
dialog box. However, the Print Manager may not close itself as it should after you abort the 
print operation, and repeated aborts may make the link between Graphmatica and the Print 
Manager unstable and prohibit printing. I am still investigating the cause of this problem, but
I will fix it as soon as I can.

Use the Printer Setup menu item to call up the setup dialog box of the current default printer
driver if you need to change the settings on your printer. If you do not have a default printer 
installed, or you want to change printer drivers, you can't use Printer Setup; you must run 



Control Panel from the Program Manager.



PRINTING POINT TABLES
 
This feature allows you to prints a table of coordinates as the program is drawing your 
graph. When you select the Print Tables option, the rightmost third of the screen is devoted 
to the Printout window: a listbox displaying the coordinates of graphs as they are drawn. 
Later you can copy the contents of the Printout window to the clipboard for importing into a 
document, printing, etc. using the Edit Copy Tables feature. This option is available to aid the
drawing of graphs by hand and provide a reference for labeling the axes if you print the 
graph without the legends on.

By default, the print tables option is OFF; it restricts the space available for the grid and the 
process does slow graphing a bit.

You can turn it on or off by selecting Print Tables in the Options menu.



Graphmatica's Command Line Arguments...

have been removed for the most part since they are not likely to get much of a workout in 
Windows where there is no command-line. All of the startup options have been moved to the
GRAPHMAT.INI file (See Saving Setup Information for details) except:

filename[.ext]

Specifying the name of a valid equation list file (with or without the ".GR" extension) loads 
that file upon startup. Unless autoredraw=off is specified in the [options] section of the file, 
the graphs are drawn as soon as the grid is drawn. You can abort the whole redraw by 
aborting one of the graphs.

You can provide any number of files for loading; the only restriction is that if they contain a 
total of more than 25 equations, some of the first equations loaded will not be stored. Also 
the graph title and options will be set to those found in the last file specified, and any other 
file's settings may be forgotten.

If you associate the .GR extension with Graphmatica (using the File Manager Associate 
command or by adding a line to you win.ini file), you can load a file by double-clicking on it 
in the File Manager.



SHAREWARE
 
Feel free to distribute copies of Graphmatica to your friends and upload it to bulletin board 
systems AS LONG AS 1) you charge no fees for its use or distribution and 2) you do not 
modify the program or documentation files in any way.

You have license to use this program as you see fit but it is to be taken AS IS with no 
warranties, express or implied.    I know of a few minor bugs, but no serious bugs that could 
cause loss of data (although with Windows a system crash is always a risk). Please tell me 
about any bugs you may find to be especially bothersome that I should correct for the next 
release.

If, after using Graphmatica, you find that it is easy, helpful, and convenient to use, please 
support the release of future versions by filling out the registration form on the next page 
and sending your contribution (payable to Keith Hertzer) to the address below:

kSoft, Inc.
345 Montecillo Dr.

Walnut Creek, CA 94595-2613

If you send $20 or more, you will be registered to receive a diskette with the next versions of
Graphmatica for Windows and DOS when they become available, along with promotional 
copies of other kSoft programs. For releases after that, you will be informed that a new 
version is available and where you can download it.

Graphmatica support is now available via CompuServe®. From now on, new releases will be 
uploaded to the Math and Science forum. (Type "GO SCIENCE".) If you have any questions or 
feedback, send me e-mail. (My user ID is 70711,2071. )

Even if you cannot send any money, please help me out by filling out the response form 
found in REGISTER.TXT and (e-)mailing it to me, especially if you have any suggestions 
about what I should add to the next upgrade.

WHAT'S NEXT? This is the first release of Graphmatica for Windows, written in about 3 
months as my first attempt at using the Windows environment. There are several weak 
points I intend to work on, like color and font support. Doubtless as I become more adept at 
using the Windows resources, Graphmatica will become easier to use and more visually 
striking. Graphmatica for DOS will continue to be available, functionally equivalent to the 
Windows version but still able to run on less powerful platforms. I also plan to begin work on 
a version for X/Windows in 1992 which will be available on Unix networks.

If you would like a copy of the source code for Graphmatica (compiled under Microsoft 
QuickC® for Windows version 1.0), please send me $20 and a short note telling why you 
would like it.


